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CHAPTER 1  

About This Manual 
 
 

In This Chapter 
General .......................................................................................................2 
Manual Structure and Use ..............................................................................2 

 
 

General 
Information in this document is subject to change without notice. Optibase Technologies 
assume no responsibility for any errors that may appear in this manual. Companies, 
names and data used in examples herein are fictitious unless otherwise noted. No part 
of this document may be copied or reproduced in any form, or by any means, electronic 
or mechanical, for any purpose, without the express written permission of Optibase 
Technologies. Optibase makes no warranties with respect to this documentation and 
disclaims any implied warranties of merchantability or fitness for a particular purpose. 
From time to time changes may occur in the file names and in the files actually included 
on the distribution disks. Optibase makes no warranties that such files or facilities, as 
mentioned in this documentation, exist on the distribution disks or as part of the 
materials distributed. 

 

Manual Structure and Use 
This manual is structured in a modular format, containing the following sections: 
• MGW Micro Premium Overview (on page 3) 

Describes the MGW Micro Premium product, its system requirements and I/O 
specifications.  

• Getting Started (on page 7) 

Describes how to connect to the appliance for the first time. 

• MGW Micro Premium Reset (on page 14) 

Describes how to reset the appliance. 

• Setup and Operations (on page 15) 

Describes how to set and configure MGW Micro Premium appliance, obtain an event 
log and upgrade software and firmware versions. 

• Playing MGW Micro Premium Video Streams  (see "Playing Back MGW Micro Premium 
Video Streams" on page 33) 

Describes how to set up players to view MGW Micro Premium channels playback. 

 
 

User Manual, Version 1.0 2 

 



 

CHAPTER 2  

MGW Micro Premium Overview 
 
 

In This Chapter 
The Product................................................................................................. 3 
System Requirements................................................................................... 3 
License and Upgrade .................................................................................... 4 
I/O Specifications......................................................................................... 4 

 
 

The Product 
MGW Micro Premium is an advanced industrial-grade, MPEG-4 H.264 portable encoding 
and streaming appliance. With TurboVideo™ technology, MGW Micro Premium Encoder 
is designed for low latency streaming of high-definition and standard-definition video 
sources across the enterprise, utilizing minimal bandwidth while preserving broadcast-
quality video up to full HD 1080p60 resolution. 

The streams can be viewed using Optibase's EZ TV or FITIS systems or with standard 
H.264 video players. Refer to Playing Back MGW Micro Premium Video Streams (on 
page 33).  

The MGW Micro Premium package includes: 
• The MGW Micro Premium appliance 

• Power supply 

• Breakout cable for analog video and audio inputs 

• CD containing the MGW Micro Premium User Manual and brochure. 

Optional parts (purchased separately): 

• Metadata cable for insertion of real-time CoT (Cursor-On-Target) data over serial 

• Mounting rack  for mounting up to two MGW Micro Premium appliances in a 
single rack row 

• 4x rubber feet for the MGW Micro Premium appliance (screw into the bottom 
mounting holes).  
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System Requirements 
Operating System:  

• Microsoft ® Windows XP ® 

• Microsoft ® Windows Vista ® 

• Microsoft ® Windows 2003  ® (32-bit and 64-bit) 

• Microsoft ® Windows 2008  ® (32-bit and 64-bit) 

• Microsoft ® Windows 7  ® (32-bit and 64-bit) 

• Apple  ® MAC OS  ® 10.6 or higher 

Internet Browser: 

• Internet Explorer 7 ® 

• Internet Explorer 8 ® 

• Internet Explorer 9 ® 

• FireFox 3.6  ® or higher (windows and Mac) 

• Safari 4 ® or higher (Mac) 

• Google Chrome ™ 
 

License and Upgrade 
MGW Micro Premium Software Licensing  

The following two MGW Micro Premium licenses are available for the MGW Micro 
Premium Encoder: 
• SD license- provides Standard Definition encoding capabilities 
• HD license - provides both Standard and High definition encoding capabilities.  

Refer to The General Page (on page 30) section for instructions for upgrading MGW 
Micro Premium license. 

 

MGW Micro Premium Firmware  
Vitec and Optibase periodically release new firmware versions that include critical 
updates as well as feature enhancements. Refer to The General Page (on page 30) 
section for instructions for upgrading MGW Micro Premium firmware. 
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I/O Specifications 
MGW Micro Premium Front Panel 

 

 
LED/ Port LED Status Description 
Stream LED Off 

Green 
 

No stream 

Streaming 

Video in LED Off 
Green 
 

No video input 

Video input exists 

Power LED Off 
Green 

Blinking 
green 

The appliance is off. 

The appliance is up and ready. 

The appliance is starting. 

Error LED Off 
Red 

All services are running. 

When error occurred in one service or 
more the LED turns red.  

USB port  USB connection (factory use only). 
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MGW Micro Premium Rear Panel 

 

 

NOTE:  
KLV serial cable must be purchased separately. 

 
Connector Label Connectors Description 

STRM RJ-45 Gigabit Ethernet for streaming (primary) 
and management (secondary). 

MGMT RJ-45 100 Base-T Ethernet for management 
(currently not in use). 

RESET  Short press will restart the appliance. 

Long press (3 seconds) will cause return 
unit to factory settings. 

POWER +12V  Power input. 

AUDIO Mini jack Mini jack audio connection. 

DVI-I  DVI-I/A/D input. 

HDMI  HDMI input. 

HD/SD-SDI 1/2 BNC 3G/SDI input (SD and HD).  

ANALOG 
VIDEO/AUDIO 

Micro DB25 
breakout cable 

Four channel-connector: composite/S-
video and unbalanced stereo audio per 
channel 

SERIAL-1/2 Micro DB9 Connecting RS-232 input for ingesting 
metadata. 
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Getting Started 
 
 

In This Chapter 
Logging on .................................................................................................. 7 
Initial Connection and Setup .......................................................................... 8 
Rack Mounting............................................................................................12 

 
 

Logging on 
MGW Micro premium requires a password to logging on.  

To log on to MGW Micro Premium: 

1. Invoke the MGW Micro Premium application by entering in your browser's URL field 
either the default appliance's IP address or the new one you have set. The login 
window appears. 

 

Figure 3-1 :The Login window 

2. Type the password (the default password is "1qaz!QAZ") and click the blue arrow. 
The MGW Micro Premium interface is loaded. 

 

User Manual, Version 1.0 7 

 



 

 MGW Micro Premium Low-Latency Multi-Channel Compact H.264 Appliance 
 
 

User Manual, Version 1.0 8 

Initial Connection and Setup 
The MGW Micro Premium is configured, by default, to use a fixed static IP address for its 
streaming port (labeled “STRM”). Use the default 192.168.1.1 IP address to perform 
initial login from a computer connected directly to the platform. 

To configure the appliance's network settings for the first time: 

1. Connect a power source to the rear power input port. 

2. Connect the network port labeled “STRM” to a computer in the 192.168.1.x range 
with subnet 255.255.255.0 and ensure you can ping the default IP address of the 
unit to 192.168.1.1. 

3. Either use Internet Explorer browser or open a Telnet terminal. 

To configure the appliance's network settings for the first time through the browser:  

1. Type the appliance's IP address in the URL field. The login window appears. 

 

Figure 3-2 :The Login window 

2. Type the password (the default password is "1qaz!QAZ") and click the blue arrow. 
The MGW Micro Premium interface is loaded. 
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3. From the main menu select System. The system page opens. 

 

Figure 3-3 :The System page 

4. Set the following parameters and click Apply.  
 

 

CAUTION:  
 When you change the appliance’s IP address to a different subnet you may need to reconfigure your 
computer network settings to re-connect to the appliance. 

 
Parameter Description 
Enable DHCP Select the check box to enable DHCP. 

IP Address Enter static IP address. 

Subnet Mask Enter the subnet mask address. 

Default Gateway Enter the default gateway address. 
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To configure the appliance's network settings for the first time using Telnet:  

1. Open a Telnet terminal. 

2. Connect to the MGW Micro Premium IP address. 

3. At the login prompt type "root" and at the password prompt type "1qaz!QAZ".  

 
The main menu appears: 
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4. Press "2" for Network Settings option. 

 

5. Type "2" for Change Streaming NIC Settings option. 

6. Set the Enable DHCP as follows: 

• If you wish to use DHCP type "true". 

• Press the Enter key to maintain the "false" value if you wish to use static IP 
address and then set the following values: 

 Enter the appliance's new IP address.    
 Enter the appropriate subnet mask. 

 Enter your default gateway address. 
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7. When done, follow Telnet "Exit" instructions on screen and close the Telnet window 
to save the settings. 

 

 

CAUTION:  
If you have changed the appliance’s IP address to a different subnet you may need to 
reconfigure your computer network settings to re-connect to the appliance. 

 
 

Rack Mounting 
You are provided with the option to mount MGW Micro Premium.  To mount the 
appliance, order separately the designated mounting part from Optibase.   

 

 

Figure 3-4 :MGW Micro Premium Mounting Rack 
 

 

NOTE:  
• The mounting part can host two MGW Micro premium appliances 

side by side. 

• The mounting part is 1-RU high. 

 

To mount the MGW Micro Premium appliance: 

1. Secure the racking bar to the rack. 

2. Unscrew the two inner screws from the front panel of the micro premium. 

3. Position the micro premium behind one of the mounting slots and align the 
appliance's mounting holes with the holes on the racking bar. 

4. Use the screws extracted from the appliance to secure the appliance to the racking 
bar. 
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CHAPTER 4  

MGW Micro Premium Reset 
 
 

 

 

In This Chapter 
Resetting MGW Micro Premium Settings .........................................................14

 
 

Resetting MGW Micro Premium Settings 
The appliance can be reset in one of the following ways: 
• Hardware reset. 
• Software reset. 

To reset the MGW Micro Premium (Hardware): 

1. On the MGW Micro Premium rear panel press the RESET button. Short press will 
restart the appliance, long press (3 seconds) will cause return unit to factory 
settings. 

To reset the MGW Micro Premium (through the application): 

1. In the General page, click Factory Reset to reset all values to default factory 
values. 

 

2. Click Yes. 
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Setup and Operations 
 
 

In This Chapter 
Using the MGW Micro Premium Interface ........................................................15 
Dashboard Frame........................................................................................17 
The Dashboard Page....................................................................................19 
The Channels Page ......................................................................................20 
The System Page ........................................................................................24 
The Event Log Page.....................................................................................27 
The Configurations Page...............................................................................28 
The General Page........................................................................................30 

 
 

Using the MGW Micro Premium Interface 
MGW Micro Premium Functions 

The followings are available at all times (regardless which menu item is selected): 

1. Dashboard frame - top of page from which channels are controlled and monitored. 

2. Encoding Mode - allows you to set the encoding mode. 

3. Logout - allows you to log out the application. 

4. About - provides information about MGW Micro Premium. 

The Main Menu 
The MGW Micro Premium main menu includes the following items: 

Dashboard - view platform, network and traffic information. 
• Channels - view and set the following channel parameters: source, processing and 

target. 
• System - view and set appliance's parameters such as date and time, network, 

communication etc.   
• Event Log - filtered view of channel's related events. 
• Configurations - allows saving of channel configurations. 
• General - view system information such as software version, licensing and provides 

restart, firmware and license upgrade functions. 
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NOTE:  
To accept changes you must click Apply. If you don't click Apply and you click another move to 
one of the other menu items: Dashboard, Channels, System etc., the following warning appears: 

  

 

 

Figure 5-1 :MGW Micro Premium Main page 
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Dashboard Frame 
In the dashboard frame section you set the encoding mode and control the channel 
playback. 

 

Figure 5-2 :The Dashboard Frame 

To set the encoding mode: 

1. From the Encoding Mode drop-down list select one of the following modes: 

 
Mode Description 
Broadcast  Single SD/HD channel, highest Video quality, up to 1080p60, 

standard latency. 

Low Latency Single SD/HD channel, low Latency, up to 1080i60.  

Turbo Video Single SD/HD channel, ultra low Latency, up to 1080i60. 

Multi-Stream Up to four SD/HD channels, Low Latency, up to Standard 
Definition NTSC or PAL. 

 

 

NOTE:  
You can change encoding mode only when all channels are in a "stopped" state. 

 

The appliance saves the current encoding mode configuration and the Dashboard 
display changes accordingly. 

  

Parameter Display Description 
Num 1-5 Displays the channel number (Static location). 

Channel 
Name 

 Display the channel name as set by the 
Administrator.  

Source  Displays the source type assigned to the channel. 

Bit-Rate  Display the total bit-rate of the channel 
(Video+Audio+overhead) 

Resolution  Displays the video resolution. 

 



 

 MGW Micro Premium Low-Latency Multi-Channel Compact H.264 Appliance 
 
 

User Manual, Version 1.0 17 

Status • Playing  
• Stopped  
• Error 

Displays the status of the channel. 

Hovering over an "Error" state brings up a tool tip 
with description of the error. 

Control Play/Stop  

 A/V Settings 

 Event Log 

Displays the channel status and allows you to 
change it as well as view events related to the 
channel.  

The following are three channel's states: 

• Stopped – Orange. The settings for this 
channel are configured but the channel has not 
been activated by the user.  

• Playing – Green. The channel is encoding and 
streaming without any known errors.  

• Error – Red. The channel has encountered an 
error. This state applies ONLY to channels that 
were started by the user.  

A/V Settings - Brings up a window in which the 
following Audio/Video parameters can be set on-
the-fly: Hue, Brightness, Contrast, Saturation, 
Force Test Pattern and Audio Gain.  

  
Event Log - displays an event log for the selected 
channel. 

KLV  Indicates if KLV metadata is being inserted into the 
stream (enabled or disabled). 

Target 
Address 

• Multicast IP 
• Unicast IP 

Displays the target IP address. 

 Target Port  Displays the port number of the target. 
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The Dashboard Page 
The Dashboard page is the main page displaying the appliance's view and displays 
network information for both management and stream interfaces as well as overall 
traffic summary. 

 

Figure 5-3 :The Dashboard page 

 Interfaces with valid input source appear in green (see figure below). 
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To view the dashboard parameters: 

1. From the main menu select Dashboard. The following parameters are displayed: 

 

Section Description 
Streaming 
Interface 

IP Address – Display the "streaming" NIC IP address. 

Subnet Mask – Display the "streaming" NIC subnet mask address. 

Default Gateway – Display the "streaming" NIC Default Gateway 
address. 

Management 
Interface 

IP Address – Display the "management" NIC IP address. 

Subnet Mask – Display the "management" NIC subnet mask 
address. 

Default Gateway – Display the "management" NIC Default 
Gateway address. 

Traffic Summary Outgoing Streams – Actual stream BW from both NIC’s. 

Serial 1 TX – Bytes transmitted from the serial 1 port. (KLV - Live)  

Serial 1 RX - Bytes received from the serial 1 port. (CoT - Live) 

Serial 2 TX – Bytes transmitted from the serial 2 port. (KLV - Live) 

Serial 2 RX - Bytes received from the serial 2 port. (CoT - Live) 

Rear Panel 
Connectors 

Displays the source inputs of the platform. Indication of the source 
current connection state is as follows: 

Green – connected 

White – not connected. 

System 
Information 

• Temperature – Displays the platform's internal temperature 
in Celsius. The value turns to red when out-of range.  

• Up Time – Display the time since last boot. 
• Date/Time – Display the platform date and time. 
• NTP – An indication LED for status of network time server. 

     Green - Synchronizing with NTP server. 

     Red - Not synchronizing with NTP server or the NTP server is    
unreachable. 
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The Channels Page 
In the Channels page you set the parameters of the following sections: 

Source - where you assign the source to use for the particular channel. 

Processing - where you set encoding parameters for the particular channel. 

Target - where you set the parameters of the output stream. 

 

Figure 5-4 :The Channels page 

To set the channels parameters: 

1. From the main menu select Channels. 

2. Set the following parameters as required in each section and click Apply. 

 

 

NOTE:  
• Options available for selection may vary according to selected (active) 

encoding mode, input in use and processing parameters. 

• A green frame appears when entered value is valid (see figure below). 

• A red frame appears when the entered value is not valid accompanied 
with a message specifying the valid value or range (see figure below). 
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Source Section 
Parameter Description 
Source Select the appropriate source. 

Detected Source Displays the detected video format. 

Audio Source Select the audio source. 

Audio Sampling  Select the audio sampling rate. 

Audio Tracks Select the audio track to process. 

Processing Section 
Parameter Description 
Video Bit-Rate Enter the video bitrate in Kbps. 

Video Codec Select the video codec. 

Encoding Format Select the video encoding format. 

Encode Audio Select the check box to activate audio encoding. 

Audio Mode Select the audio encoding mode. 

Audio Bit-Rate Select the audio encoding bitrate. 

Ingest KLV Select to ingest metadata and embed as KLV 

 Not available in "TurboVideo™" encoding mode. 

Encryption Select the encryption mode. 

• When the "Encryption" is "None", the function "AES Key" is not 
available. 

AES Key Displays the AES key (16 / 32 character string according to the 
selected Encryption mode). 

• When "Encryption" check box selected, Random key generator fills 
the text box. (Admin could delete/edit the generated string) 

•  When the "Encryption" is "None", this function is not available. 

 Not available in "TurboVideo™" encoding mode. 

Advanced Click this button to set advanced processing parameters as follows: 

Aspect Ratio – 4:3 / 16:9 

Frame Rate – Full / ¾ / 2/3 / ½ / 1/3 / ¼  (not available in 
"Broadcast" encoding mode) 

VLC Mode – Select variable length coding mode CABAC / CVLAC . 

Video PID – Default: 1241 

Audio PID – Default: 1242 

KLV PID – Default: 497 
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PCR PID – Default: 1241 

PMT PID – Default: 1240 

Program Number – Default: 1 

GOP Size – 1-1000 (Not available in "Broadcast" mode. 

Closed GOPs –Select the check box to enable it. 

Timestamp GOP – Select the check box to enable it. 

 

Figure 5-5 :The Advanced Processing window 
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Target Section 
Parameter Description 
Channel Name Enter the channel name. This name will also appear in Session 

Announcement Protocol (SAP) messages.   

Network 
Interface 

Select the network interface to stream from. 

Streaming 
Protocol 

Select the streaming protocol. 

Target Address Select the target IP address. 

Target port Select the target port. 

TTL Enter the TTL value. 

UDP Packet Size Enter the UDP packet size. 

SAP Select the SAP check box to enable Session Announcement Protocol. 

Traffic Shaping  Select the Traffic Shaping check box to enable network smoothing. 

• Not available in "Turbo Video™" mode. 

 

 

NOTE:  
You must click Apply for the new settings to be saved. 

 

 

CAUTION:  
When video source is lost or different format is selected while the channel is playing a color bar is 
displayed. In such case verify the following: 

• Source is connected 

• The video frame rate and/or resolution match the one selected for 
the channel. 
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The System Page 
In the System page you set the parameters of the following sections: 
• Streaming Interface  
• Management Interface 
• Password 
• Date and Time 
• Comm 
• SAP 

 

Figure 5-6 :The System page 

To set the system parameters: 

1. From the main menu select System. 

2. Set the desired parameters as required in each section and click Apply. 

 

To set the Streaming and Management Interfaces: 
Parameter Description 
Enable DHCP Select the check box to enable DHCP. 

IP Address Enter static IP address. 

Subnet Mask Enter the subnet mask address. 

Default Gateway Enter the default gateway address. 
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To set the Password: 

Parameter Description 
Current 
Password 

Type the current password. 

New Password Type the new password (8-14 characters). 

Re-Type 
Password 

Re-type the new password. 

Host Name Type the host name as follows: <host name>. 

The default is MGWMP<xxxx> (where the last four 
digits are the platform serial number). 

 

To set Date and Time: 
Parameter Description 
Use NTP Select the check box to enable synchronization with 

the NTP server. 

Server Address Type the NTP server address. 

Sync Period Type the synchronization period. 

Date Set the date. 

Time Set the time. 

Time Zone Set the time zone. 

DST Settings Click this button to set the start date and time for 
Daylight Saving. 

 

To set communication (Comm): 

1. In General tab set the Data Format and the Max Aircraft-SPI Delta (ms). 

2. In the Serial 1 and serial 2 tabs set the following parameters: 
Parameter Description 
Baud Rate Select the check box to enable it. 

Data Bits Select the data bits. 

Parity Select the parity. 

Stop Bits Select the stop bits. 

Flow Control Select the flow control. 
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To set SAP: 
Parameter Description 
User default SAP 
address and port 

Use the default Session Announcement Protocol 
multicast group and port as per RFC 2974. 

IP Address Set the target multicast IP address to which SAP 
massages will be sent. 

Port Set the target port to which SAP messages will be 
sent. 

Announcement 
Interval (sec) 

Set the interval between SAP messages. 

 

 

 

NOTE:  
You must click Apply for the new settings to be saved. 

 
 

The Event Log Page 
In the Event Log page you can view the log of events and export them.  

 

Figure 5-7 :The Event Log page 
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To filter the view: 

1. From the Filter drop-down list select one of the following options: 

 
 

To export event log: 

1. Click Export Log. The File Download window appears. 

 

Figure 5-8 :The File Download window 

2. Click Open to open the log. The log file is opened with a common text editor (such 
as notepad)  

 - Or - 

3. Click Save to save the file. 
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The Configurations Page 
In the Configuration page you can add, activate, and delete channel configurations. 

 

Figure 5-9 :The Configuration page 

To add a configuration: 

1. Click Add. 

 

2. Type the configuration name and description. 

3. Click Save. The new configuration appears on the top row. 

To activate a configuration: 

1. Select the desired configuration row. 

2. Click Activate to activate the configuration. The activated configuration is applied.  

To delete a configuration: 

1. Select the desired configuration row. 

2. Click Delete to delete the configuration. 
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To activate Auto Start: 

1. Select the desired configuration row. 

2. Click Auto Start. The  icon appears in the Auto Start column in the relevant 
configuration row. 

The next time the appliance restarts, the selected configuration will load 
automatically.  

 

The General Page 
In the General page you can view appliance related parameters and perform license 
and firmware upgrades. 

 

Figure 5-10 :The General page 

To view the System Information parameters: 
 

Parameter Description 
Temperature Displays the internal temperature in Celsius of the 

appliance. 

Up Time Displays the time since last restart. 

Serial Number Displays the hardware serial number. 

Management MAC 
Address 

Displays the NIC management MAC Address. 

Stream MAC Address  Displays the NIC streaming MAC Address. 

 



 

 MGW Micro Premium Low-Latency Multi-Channel Compact H.264 Appliance 
 
 

User Manual, Version 1.0 30 

To view and set Version & Licensing: 
 

Parameter Description 
Hardware  Displays the current hardware revision. 

Software Displays the active software version. 

Encoding License Displays HD or SD - depending on the purchased 
license. 

To upgrade MGW Micro Premium license: 

1. Send Optibase your upgrade license request.  

2. Upon receipt of the new license file (*.lic file) click New License, select the new file 
and follow the on-screen instructions. 

To upgrade MGW Micro Premium Firmware version: 

1. Send Optibase your upgrade firmware request.  

2. Upon receipt of the new firmware file (*.tgz file) click Firmware Upgrade. The 
Load new firmware version window appears. 

 

Figure 5-11 :The Load New Firmware Upload window 

3. Click Browse to select the new firmware file and click Load. The new version is 
loaded. 

4. Follow the on-screen instructions to complete the upload process. 
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General Page Functions 
• Click Restart to restart the appliance. 
• Click Factory Reset to reset all values to default factory values. 

 
• Click Export Settings to export channel configurations and save as a file for backup 

purposes or for importing into a different appliance.  
• Click Print Info to obtain a printed summary of vital system information. 

 

 



 

APPENDIX A 

Playing Back MGW Micro Premium Video 
Streams 
 
 

The MGW Micro Premium uses ISO compliant MPEG-4 Part-10 (H.264) compression in 
both RTSP and MPEG-2 Transport stream over UDP encapsulation protocols. The MGW 
Micro Premium streams can be viewed using the following video players: 
• Optibase EZ TV Player. 
• Optibase FITIS Player. 
• MGW Micro Premium Decoder 
• Third-party software H.264 decoders such as VideoLan (VLC) Player. 
• Third-party hardware H.264 decoders such as Amino AmiNet set-top-boxes 
• Professional H.264 IRD’s 

 

    

NOTE:  
Certain capabilities of MGW Micro Premium such as TurboVideo™ low latency streaming, AES encryption and 
MISB KLV metadata may not be supported by all third-party decoders.  Please consult with Vitec and Optibase 
support for additional information about interoperability with third-party decoders.  

 

 

CAUTION:  
When video source is lost or different format is selected while the channel is playing a color bar is displayed. In 
such case verify the following: 

• Source is connected 

• The video frame rate  and/or resolution match the one selected for the 
channel. 

 

User Manual, Version 1.0 32 

 



 

 MGW Micro Premium Low-Latency Multi-Channel Compact H.264 Appliance 
 
 

User Manual, Version 1.0 33 

Setting EZ TV as the Player 
1. In EZ TV portal go to Static Channels and click Add Channel.  

 

2. Enter the Channel Name. 

3. Enter the Channel Number. 

4. Select RTSP for RTSP or Multicast for UDP Transport Stream mode. 

5. In the IP field enter the Micro IP Address.  

6. In the Port field enter the port number. 

7. Click Publish. 

 

NOTE:  
• The above steps are partial instructions. Refer to EZ TV Portal 

and EZ TV Player user manuals for detailed instructions.  

• When SAP is enabled on one or more of Premium channels EZ TV 
will automatically discover the broadcasting and list these 
channels under Dynamic Channels in EZ TV Player.  

8. From the EZ TV Player, select the appropriate channel. The MGW Micro Premium 
stream is played on EZ TV Player under Static Channels. 

Setting FITIS as the Player  
Setting FITIS as the player is done in a similar manner as in EZ TV.  
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Setting VLC as the Player 
1. Invoke VLC Media Player. 

2. Select Media>Open Network Stream. The Open Media window appears. 

3. Select the Network tab and depending on the chosen selected streaming protocol 
(RTP or UDP) enter the following syntax in the URL field: 

• For RTSP protocol - rtsp://<IP address>:<port number>/<channel 
name> (see example in figure below). 

 

NOTE:  
• RTSP protocol is supported by the specified above 

players. 

• IP address is the MGW Micro Premium IP address. 

• Channel Name is the name as set in the Channels page, 
Target section.  
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• For TurboVideo™ you must set Caching. Click the Show more options check 
box and set the caching to a value between 120 to 140 milliseconds depending 
on your network performance.  

 

Figure 5-1 :Setting the Caching 
• For UDP protocol - udp://@<IP address>:<port number> (see example in 

figure below). 

 

NOTE:  
• IP address is the Target Address as set in Channels page, 

Target section. 

• The port number is the Target Port as set in the Channels 
page, Target section.  
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• For HTTP protocol - http://<IP address>/sdp/<Channel#> (see example in 
figure below). 

 

NOTE:  
• The indicated http path above can be also used for directing 

viewers to MGW Micro Premium video streams from within a 
web page.  

• Syntax is case sensitive. 

• IP address is the MGW Micro Premium IP address. 

• Channel number  is the number as appears in the Channels 
page, Num section.  

 

 
 

 

NOTE:  
When there is no connection between the Player and the MGW Micro Premium appliance, 
retrieve the SDP file from the appliance using any  method of your preference  with the http 
syntax as specified above. After SDP file is retrieved and accessible, use VLC's File>Open to 
upload it. 

4. Click Play. 
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To set VLC Player using SAP protocol:  

1. From VLC main menu select View>Playlist. The Playlist window appears. 

2. Under Media Browser expand Local Network and select Network Stream. A list 
of available streams appears. 

 

3. Select the desired stream you wish to play. 

 

NOTE:  
SAP must be activated in Channels page Target section as shown in figure below. 

 
 
 

 



 

APPENDIX B 

Contact Information 
 

Sunnyvale, USA 

931 Benecia Avenue 

SUNNYVALE, CA 94085 

USA 

T: +1-(800)-451-5101   

F: +1-(408)-739-1706 

 

Boston, USA 

319 Littleton Road 

Suite 107 

WESTFORD, MA 01886 

USA 

T: +1-(978)-399-0226/7 

F: +1-(978)-399-0229 

 

Atlanta, USA 

2200 Century Parkway,  

NE Suite 900 

ATLANTA, GA 30345-3150 

USA 

T: +1-(404)-320-0110 

F: +1-(404)-320-3132 

 

FRANCE 

99 rue Pierre Semard 

92324 CHATILLON Cedex 

FRANCE 

T: +33-(0)1-46-73-06-06 

F: +33-(0)9-59-85-99-92 
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GERMANY 

Lise-Meitner-Str.15 

24223 Schwentinental 

GERMANY 

T: +49-(0)4307-8358-0 

F: +49-(0)4307-8358-99 

 

ISRAEL 

7 Shenkar St., P.O. B 2170  

HERZLIA, 46120 

ISRAEL   

T: +972-(0)9-9709-200   

F: +972-(0)9-9709-222 

 

CHINA 

BEIJING, P.R. CHINA  

T: +86-(0)10-5172-7086   

F: +86-(0)10-5172-7096 

 

INDIA 

NEW DELHI, INDIA 

T: +91-98-11-770000 

 

RUSSIA 

KRASNOYARSK, RUSSIA  

T: +7-(391)-275-10-88  

 
 



 

APPENDIX C 

Warranty 
 
 

Vitec Limited Hardware Warranty Terms 

Subject to the terms and conditions specified below your Optibase product (the 
"Product") is warranted against defects in material and workmanship (the "Warranty") 
for a period of 12 (twelve) months following the Delivery Date (the "Warranty 
Period"). The Warranty provided to you hereunder supersedes any warranty which 
may be provided to you by the original manufacturer of the Product.  

Vitec Multimedia, Optibase Ltd. and/or Optibase Inc. (collectively "company") will 
repair or replace (at its option) any defective part during the Warranty Period, provided 
that (i) the Warranty remain in force. Your dated sales receipt or invoice shall be 
considered as the delivery date of the Product form Optibase's premises to your 
designated address (the "Delivery Date"); (ii) your Product unit carries a serial 
number on its rear panel; (iii) you received from Optibase Customer Service department 
a Return Materials Authorization (RMA) number. No Product unit will be accepted for 
repair without RMA number; and (iv) the entire Product unit is returned to the company 
by prepaid shipping in Vitec’s original packaging. 

Vitec will not be responsible for (i) any damages resulting from the use, maintenance or 
installation of any Product; or (ii) for the incorporation of any spare or replacement 
parts not approved by the company.  

Without limiting the generality of the foregoing, The company reserves the right to 
refuse to provide any services under the Warranty for any Product that, in the company 
opinion, has been subjected to any abnormal electrical, mechanical, or environmental 
abuse, or shows signs of modification by an unauthorized person or company. Call your 
local distributor or reseller for out-of-warranty repair charge estimates prior to returning 
a product. 

You acknowledge that the product licensed or sold hereunder, which may include 
technology and software, are subject to the export control laws and regulations of the 
United States ("U.S.") and/or any other country in which the product is received. You 
agree that you will not knowingly transfer, divert, export or re-export, directly or 
indirectly, the product, including the software, the software source code, or technical 
data (as defined by the U.S. Export Administration Regulations) restricted by such 
regulations or by other applicable national regulations to any person, firm, entity 
country or destination to which such transfer, diversion, export or re-export is restricted 
or prohibited by U.S. or other applicable law, without obtaining prior authorization from 
the U.S. Department of Commerce and other competent government authorities to the 
extent required by those laws. 
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